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Information Security  

Notice! 

This document is classified as “Restricted”. Restricted information is intended for Siemens’ 
employees and third parties (e.g., suppliers, customers) collaborating with Siemens only. This 
means that it is possible to share information in this document with third parties that are 
interested in our product on a “need-to-know” basis. However, distributing this document to 
the public or publishing it on the internet is prohibited.  
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1 Online Support  
Click the following link for technical support:  
http://www.siemens.com/lowvoltage/technical-support 

Click the following link for the list of all FAQs, Hot fixes, and Service Packs: 
www.siemens.com/Powermanager/support 
  
For additional information to work with Powermanager, refer to the Powermanager 
manual/Help. 

1.1 Security Information 

Siemens provides products and solutions with industrial security functions that support the 

secure operation of plants, systems, machines, and networks. 

In order to protect plants, systems, machines, and networks against cyber threats, it is 

necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 

security concept. Siemens’ products and solutions constitute one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, 

machines, and networks. Such systems, machines and components should only be connected 

to an enterprise network or the internet if and to the extent such a connection is necessary and 

only when appropriate security measures (e.g., firewalls and/or network segmentation) are in 

place. 

For additional information on industrial security measures that may be implemented, please 

visit https://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more secure. 

Siemens strongly recommends that product updates are applied as soon as they are available 

and that the latest product versions are used. Use of product versions that are no longer 

supported, and failure to apply the latest updates may increase customer’s exposure to cyber 

threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 

under https://www.siemens.com/cert. 

  

http://www.siemens.com/lowvoltage/technical-support
https://support.industry.siemens.com/cs/products?mfn=ps&pnid=19789&lc=en-WW
https://www.siemens.com/industrialsecurity
https://www.siemens.com/cert
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2 Overview 
Powermanager allows you to migrate projects of powermanager V3.6 HF1 to powermanager V5.1 

or higher. 

This process includes migration of configurations and data of the projects. Configurations of the 

project including all device, report, and system settings and system trends are part of the 

migration operation. Archived data over required period for selected devices is also a part of this 

operation.  

NOTE:  For the ease of reference, all powermanager versions above V5.1 will be referred as new 

powermanager. 

You can perform this operation by using the migration tool. The migration operation consists of 

two key workflows: 

- Export from powermanager V3.6 HF1: Allows you to select the configurations and the 

data to be migrated from powermanager V3.6 HF1 to new powermanager. 

NOTE: You should have powermanager V3.6 HF1 to perform the export. Upgrade to 

powermanager V3.6 HF1, if you are using an older version of powermanager. 

 

- Import to new powermanager: Allows you to import the exported files from 

powermanager V3.6 HF1 to new powermanager. 

NOTE: You should have new powermanager to perform the import. Upgrade to new 

powermanager if you are using an older version of powermanager. 

Migration Rundown: 

To save time, we recommend you perform the procedures involved in migration workflow in the 

following sequence: 

1. Configuration Export 

2. Configuration Import 

3. Data Export  

4. Data Import 

new powermanager and powermanager V3.6 HF1 must be available in two different machines to 

perform the procedures in the recommended sequence. Refer section Hardware Category 

Definitions in System_Description_pm_7.0 document for hardware requirements. Ensure that the 

machines involved in the migration process are in the same time zone. 

NOTE: To transfer the exported folders from one machine to another, you are recommended to 

have USB stick or USB Hard disk. 

Below are few important details to be noted before continuing with the migration operation: 

• Only server projects can be migrated. If you have an existing client setup, you must setup 

the client afresh in new powermanager. 
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• Custom panels are not included in this migration operation. Refer new powermanager 

Help for more information on working with Graphics Editor to create similar templates. 

• The device types that are not supported in new powermanager but supported in 

powermanager V3.6 HF1 must be imported as Third-party device types in new 

powermanager. Refer Prerequisites for Import section below for more information. 

• Device and Area/System level device type configuration are not migrated for Third-party 

device types, Classic device types (PAC1500, 3VL COM21, GMD), SEM3 and PAC1200. 

However, Archival configuration for the devices will be migrated in case the measurement 

point is selected for data migration and data is available. 

• The migration of the distributed system must be done for each project separately.  

If the distributed project has source elements from another distributed project, then 

those source elements will not be migrated and has to be re-configured in new 

powermanager system after migration. 

Migration of devices is handled as below: 

Device Migration 

Supported 

Comments 

PAC Devices ✓ PAC1500 is migrated as a third-party device type. Refer 

Prerequisites for Import section for more information. 

SEM3 ✓ - 

SICAM Devices ✓ P850 and P855 will be migrated as PAC5100 and PAC5200 

respectively. 

Breakers ✓ 3VLCOM21 is migrated as a third-party device type. Refer 

Prerequisites for Import section for more information. 

Generic Modbus 

Device 

✓ This device type is migrated as a third-party device type. 

Refer Prerequisites for Import section for more information. 

Manual 

Measuring Device 

 - 

Virtual Devices 

(Logical Devices) 

✓ • Virtual devices include: 

- Average Value 

- Calculation Value 

- Virtual Counter 

- Converter 

• KPI is migrated as a virtual device type. 

• Virtual devices are not listed for data export. All the 

result values are selected for export. 
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Monitoring 

Functions 

 Monitoring functions include Limit Control and Load 

Monitoring. 

Third-party 

Devices 

(XML imported 

Third-party Device 

types) 

✓ - 

• The descriptions of Areas and Sectors are not migrated from powermanager V3.6 HF1 to 

new powermanager. 

• System and Area level configurations of PAC5100 and PAC5200 device types are 

considered for P850 and P855 device type respectively in new powermanager. 

• OPC UA/DA and MindSphere configurations are not migrated to new powermanager. 

• Manually corrected values are migrated. 

• Alarm configuration of 3VLCOM21, PAC1500, GMD and third-party device types (xml 

imported device types) will not be migrated. If necessary, reconfigure the alarms after 

migration. 
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3 Export from powermanager V3.6 HF1 
This section provides information on the export operation required for migration. 

 

Pre-export Checklist: 

• Ensure you have sufficient disk space available for the export operation. 

• Archive backups of powermanager V3.6 HF1 should be re-mounted if needed for data 

export. 

• Ensure you take project and data backup before migration. 

3.1 Prerequisites for Export 

Login to powermanager V3.6 HF1 and verify all the required configurations and data of the project 

to be migrated are available. Perform the following steps to run the Powermanager Migration 

Export Tool. 

• Download and unzip the file containing the Migration Tool from the SIOS portal. 

 
• Run the pmMigration batch file as administrator. 

- You will be prompted to enter the project path. 
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• Select the path of the project you want to migrate. 

The path can be like the below example: 

C:\SENTRON\ProjectName 

• Enter the project path and press Enter. 

 
• Stop the project and close all powermanager applications and consoles to proceed with 

migration.  

 

NOTE: The Powermanager Migration Export tool is available in English and German languages. 

The language will be selected by the tool depending on the available operating system. The 

language is set to English for all operating systems other than German. 
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• Restart the project to be migrated. 

- The Powermanager Migration Export tool login screen appears. The Powermanager 

Migration Export tool is added as a new User Interface (number 10) in the powermanager 

Console. 

 
• Enter the Username and Password used to login to powermanager V3.6 HF1 project to 

login to the migration tool. 

 

NOTE: You must be a powermanager V3.6 HF1 Admin user to login to the Powermanager 

Migration Export tool. 
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The Powermanager Migration Export tool is now available. 
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3.2 Configuration Export 

Ensure that all the prerequisites mentioned in the Prerequisites for Export section are met. 

Perform the following steps for Configuration Export. 

NOTE: We recommend you stop all device communication before proceeding with the export 

operation. 

Devices Tab 

• Select the required description language from the Languages section. 

 
Languages: Allows you to select the description language. This section has the following options: 

     Language 1: Displays the default language assigned for all descriptions. This field cannot be 

     changed. 

     Language 2*: Allows you to select the description languages from the available list of supported 

     languages. This is a mandatory field. 

• By default, all supported devices from the Devices section will be selected. 

 
Devices: Allows you to select the device configurations to be migrated. This section has the 

following columns: 

     Select: Select the checkbox under this section to select the device. All the devices supported for 

     migration is selected by default. Migration non-supported devices are highlighted in grey and   

     cannot be selected for migration. Such devices are not migrated even as Third-party devices.       

     Device Name: Displays the name of the selected device. 

     Device Type: Displays the device type. 

     Device Group: Displays the device group. 

     Area: Displays the area under which the device is available. 

     Sector: Displays the sector hierarchy under which the device is available. 

NOTE: Device passwords are not included in the migration operation. Update the device passwords in 

new powermanager after the completion of migration. 
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• Select the required third-party device type XMLs under the Select Third Party Device XMLs 

section. 

 
• Select Third Party Device XMLs: Allows you to select the required third-party device type XML to be 

migrated. This section has the following columns: 

     Third-Party Device Type: Displays the third-party device type 

     Number of Devices for the device type: Displays the number of devices of the device type. 

     Select XML file used for creating the third-party device type: Allows you select the third-party   

     device type XML files. 

     Path of XML: Displays the location of the third-party device type XML files. 

• Click Save. 

NOTE: You must select the XML files for all the third-party devices selected in the Devices section. 

Report Templates Tab 

• By default, all the Report Templates will be selected. De-select any report templates if 

required. 

Report Templates: Allows you to select the report templates. This section has the following 

columns. 

     Select: Select the checkbox under this section to select the required report template. All the 

     report templates are selected by default. 

     Report Template: Displays the report template name.  

     Report Type: Displays the report type. 

NOTE: 1) Only report templates are migrated and not the generated reports. 

            2) Migration is not supported for Sankey Report. 

            3) Only scheduling configuration of the Top 10 report templates is migrated. 

            4) The Power peak analysis is migrated as a report template. 
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            5) KPI and Energy Export report templates are migrated as Standard report templates in  

                 new powermanager. 

• Click Save. 

Miscellaneous Tab 

• Create email configurations backup under the E-mail Configurations section. 

E-mail Configurations: Allows you to create a backup of the email configurations.  

Select Yes to create a backup of all email configurations. 

NOTE: We recommend you create a backup of the email configurations. The backup file is not 

imported as a part of the migration import operation. Refer the backup file to configure the E-mail 

in new powermanager. 

 

• Create reactions backup under the Reaction Plans section. 

Reaction Plans: Allows you to create a backup of the reactions. 

Select Yes to create the backup of all reactions. 

NOTE: We recommend you create a backup of the reactions. The backup file is not imported as a 

part of the migration import operation. Refer the backup file to configure the reactions in new 

powermanager. 

 

• Create system alarms backup under the System Alarms section. 

 
System Alarms: Allows you to create a backup of the system alarms. 

Select Yes to create backup of all system alarms. 

NOTE: We recommend you create a backup of the system alarms. The backup file is not imported 

as a part of the migration import operation.  

 

• Migrate system settings under the System Settings section. 

 
System Settings: Allows you to migrate all system settings. 

Select Yes to migrate all system settings and configurations. 
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All archive smoothing, driver smoothing, system dashboard, and synchronization configurations are 

included. 

 

• Migrate system trends under the System Trends section. 

 
System Trends: Allows you to migrate all system trends. 

Select Yes to migrate all system trends. 

 

• Click Save. 

Export Tab 

• Select the path for the export and complete the configurations export under the Export 

Configuration section. 

 
Path: Allows you to select the path to where the files need to be exported to. 

Export Configuration: Allows you to complete the complete configurations export. 

The file containing the configurations export is available in the above specified folder. 

  



16 of 35 Powermanager, Migration Tool 

 L1V30600299C | Edition 08.2023 

3.3 Data Export 

Archived data over required period for selected devices is also a part of this operation. To perform 

data export, ensure that the configuration export is complete, and all the prerequisites mentioned 

the Prerequisites for Export section are met. Perform the following steps for data export.  

Measurement Points Tab 

• Select Archive Configuration for the measurement points to be migrated. 

 
  

Devices: Allows you to select the devices for which the data must be exported. All the devices 

selected in the configuration export are listed here. 

Default: Select to export the measurement points that are archived by default when a device is 

created in new powermanager. 

Example: The measurement points archived by default for a PAC3200 device are active energy 

import tariff 1 and cumulated active power import.  
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Current: Select to export all the archived measurement points configured in powermanager V3.6 

HF1. 

 

Custom: Select to choose measurement points from all the archived measurement points for the 

selected device in powermanager V3.6 HF1. 

 

NOTE:  Logical devices are not listed for data migration. All the result values are selected for export. 
 

• Select the devices for which the measurement points need to be exported under the Third 

Party Devices section. 
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Devices: Allows you to select the devices for which the data must be exported. All the third-party 

devices selected in the configuration export are listed here. 

Current: Select to export all the archived measurement points configured in  

powermanager V3.6 HF1. 

Custom: Select to choose measurement points from all the archived measurement points for the 

selected device in powermanager V3.6 HF1. 

 

• Click Save. 

Duration Tab 

• Select the duration for which the data must be exported. 

 

NOTE: The default time duration for the data export is from the selected start time to the time 

configuration export is completed. 

 

Duration for Energy Consumption & Power Interval Values: Allows you select the duration for 

which the data must be exported for energy consumption and power interval values. This section 

has the following options. 

Select*: Select the duration for which the data must be exported from this dropdown. 

Start time: Displays the start date and time for the selected duration, if the default duration is 

selected in the Select* dropdown. 

Allows you to select the start time and date, if the custom option is selected in the Select* 

dropdown. 
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End Time: Displays the end date and time for the selected duration, if the default duration are 

selected in the Select* dropdown. 

Allows you to select the end time and date, if the custom option is selected in the Select* 

dropdown. 

 

Duration for all Other Values: Allows you to select the duration for which the data must be 

exported for all other values except energy consumption and power interval values. Default 

duration is set to 3 months. 

NOTE: Other values data (excluding energy consumption and power interval) can be exported only 

for last three months.  

Time Based Smoothing: It allows you to reduce the volume of data to be exported. 

Smoothing Interval: Select the smoothing interval for time based smoothing. This helps to reduce 

the amount of data considered for migration and to reduce the SQL size needed. After the 

smoothing interval time has elapsed, the next value will be considered for migration. Any values 

during the smoothing interval are discarded. 

 

• Click Save. 

Export Tab 

• Click Calculate Quick Forecast or Calculate Detailed Forecast to view the SQL storage 

analysis needed for new powermanager database. 

 
SQL Storage Forecast Quick Analysis: Provides you a detailed estimate of the required SQL storage 

space. 

SQL Storge Forecast Detailed Analysis: Provides you a detailed estimate of the required SQL storage 

space. This process can take a few minutes to an hour depending on your data. 

 

• Click Data Export in the Data Export section to proceed with the export operation. 

 
Export Data: Displays the path where the data export files are made available. 

 

The file containing the data export is available in the above specified folder. 
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3.4 Post Export Operations 

Perform the following steps to proceed with migration. 

• Copy the files containing the configuration and data export to the machine with new 

powermanager. 
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4 Import to new powermanager 
This section provides information on the import operation required for migration. 

Pre-import Checklist:  

• During installation of new powermanager, select checkbox Migration (select if you are 

migrating from powermanager V3.6 HF1) and click Next.  

NOTE: If the checkbox is not selected, Powermanager Migration feature will not be 

available after installation. 

To add Powermanager Migration feature post installation follow the below steps: 

- Launch Powermanager SMC and Navigate to Projects node.  

- Click Stop. 

 

 

- Close all the applications related to powermanager. 

- Launch Update powermanager V7.0 from desktop. 

NOTE: If Update Powermanager V7.0 is not available on desktop, refer to path 

"C:\Siemens\SENTRON\powermanager\GMSMainProject\Bin\Gms.InstallerSetup.exe" 

Administrative rights are required to launch Update Powermanager V7.0. 
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- Click Yes on User Account Control window. 

 
 

- Click Next. 
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- Select Server and click Modify for Feature Selection. 

 

 

- Click Add Em. 
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- Browse for powermanager setup folder. 

- Navigate to powermanager setup folder\DCC\EM\Powermanager_migration and 

click OK. 

  
 

- Click OK. 
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- Click Next. 

 
 

- Click Next. 
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- Click Install. 

 
 

- Click Close. 
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• Add Powermanager Migration feature in the project using the below steps: 

- Launch Powermanager SMC and navigate to Projects node.  

- Select project name and click Add to project. 

 

 

- Select Powermanager Migration and click OK. 

 
 

- Click Save. 

- Start the project. 

• Ensure that you have the required new powermanager license available and activated. 

Licensing for powermanager is controlled through a tool called, License Management Utility (LMU). 

Once powermanager is installed, the License Management Utility (LMU) is installed on every 

system.  

Before launching the powermanager client application, you must first enable and manage licenses 

for powermanager. Otherwise, only the demo licenses are configured, and you will need to close 

the powermanager client application in very short time. 



28 of 35 Powermanager, Migration Tool 

 L1V30600299C | Edition 08.2023 

To protect powermanager against piracy, a special activation is required. You can activate the 

license for powermanager from LMU using the below steps: 

- Launch SMC either by double-clicking the SMC icon on the desktop or from 

Windows Start menu. 

- Refer to Help > Engineering Step-by-Step > Installing the Software > Additional Installer 

Procedures > Activating a Customer License. 

• Ensure that new powermanager supported version of SQL is available.  

• Ensure that database size and storage size are sufficient corresponding to the SQL forecast 

of the SQL operation. 

• Ensure that a historical database (HDB) is connected and accessible to the project, the 

long term storages created and switched to ON state.  

You can create long term storages using the below steps: 

- Launch Powermanager SMC either by double-clicking the SMC icon on the desktop or from 

Windows Start menu and click Yes. 

- In the SMC System tree, select History Infrastructure. 

- Click Scan Local. 

- When the scan is completed, select GMS_HDB_EXPRESS SQL. 

- Click Link. 

- Click Add to create the HDB. 

- In the Long Term storage section, click Add Storage to create long term storage. 

- Select the Start check box for the storage. 

- Click Save. 

The History Database is created and displays in the SMC tree. This may take a few minutes 

depending on the selected database size. When you create a new HDB it gets automatically linked 

to the SQL Server. The long term storage is created when the state in the State column in the 

Storage table changes to ON. 

For additional information, refer to Powermanager Help >Engineering Step-by-Step > Setting Up the 

Project > Creating History Infrastructure > Create a New HDB with Long Term Storage. 
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4.1 Prerequisites for Import 

Ensure that new powermanager Server is installed, refer to Readme.pdf (section 4.1 Installation 

Prerequisites). You have the privileges of a DefaultAdmins user or a PowerManagerAdmins user. 

If user had reports scheduled in powermanager V3.6 HF1, ensure that Software user account is 

created in new powermanager, and group membership is assigned to PowermanagerAdmins. 

Enter created Software account username during configuration import. To create new user, 

navigate to Management view > Users. 

Refer new powermanager help section for more details: Engineering Step-by-Step > User and User 

Group Administration > User Administration. 

NOTE: Migration is not supported for new powermanager Client setup.  

Perform the following steps to proceed with migration: 

• Copy the files containing the configuration and data export to the machine with new 

powermanager. 

• Create the third-party device types, if any. 

You must create the third-party device type to be migrated in new powermanager. JSON files for 

corresponding third-party device types are created by the migration tool during the configuration 

export. These JSON files are available in configuration export folder. You can create third-party 

device types using the below steps: 

- Select Applications > Powermanager. 

The System tab displays. 

- Select Third Party Device Type expander and proceed as follows: 

▪ Drag and drop the library to the Library Name field. 

▪ Click Browse to select the JSON file. 

▪ In the Open dialog box, select the required JSON file from the location and click Open. 

 

- Click Create Device Type. 

NOTE: Device types like 3VLCOM21 and PAC1500 are supported in powermanager V3.6 HF1 but not 

supported in new powermanager. JSON files for these device types are created as a part of the export 

operation. 

These files are available in path: [Projectname]_Backup_For_Migration(yyyy-mm-dd-

hh.mm)\Configuration\Device\Classic_DeviceType_Jsons. 

• Edit the JSON files for the Generic Modbus Device (GMD) types, if any. 

A JSON file is created for GMD type by the migration tool during the configuration export. This 

JSON file is available in configuration export folder.  

Open the JSON file of the GMD type using the powermanager device engineer tool. Perform the 

required property configurations and create the new JSON files for corresponding GMD groups. 

Consider the below example to create GMD device type JSON files in powermanager device 

engineer tool: 

- Open JSON file GenericModbusDevice_Classic from configuration export folder in third-party 

tool PowermanagerDeviceEngineer. 
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- Review and configure Device Features page properties as per powermanager V3.6 HF1 and 

click Next. 

- Review and configure Device properties page properties and click Next. Make sure the 

property configurations are correct and configured as per powermanager V3.6 HF1 GMD 

device type. 

- Review and configure Device Configuration and save the JSON file. 

- If necessary, rename the device type using Edit option from Device Type Name. 

NOTE: Do not rename the datapoint properties. If you rename, configuration and data import 

failure will occur. 

• Logical grouping of GMDs: 

- If multiple GMDs are created with same configuration in powermanager V3.6 HF1, then during 

bulk device creation in new powermanager, you must select the same device type. 

- For different GMD configurations of powermanager V3.6 HF1, individual JSON files should be 

configured in powermanager device engineer tool. 

- One JSON file should be created for one type of configuration and that type should be selected 

during bulk device creation.  

- Consider the below example to understand logical grouping of GMD and create corresponding 

JSON files in powermanager device engineer tool: 

Consider three devices GMD1, GMD2 and GMD3 in powermanager V3.6 HF1.  

GMD 1 has configuration 1 and GMD2 has configuration 2 and GMD3 has similar configuration 

as GMD1. In this case user must create two separate GMD device types: 

▪ One device type JSON for GMD1 and GMD3 as they have same configuration 

▪ One device type JSON for GMD2 

• Create the devices in new powermanager under Bulk Devices Creation tab: 

- In Engineering mode, click Bulk Device Creation. 

- Browse .csv file to create devices. 

NOTE: A .csv file with the device configurations is created during the export operation. Use this 

.csv to create the devices. 

These files are available in path: [Projectname]_Backup_For_Migration(yyyy-mm-dd-

hh.mm)\Configuration\Device\BulkDeviceCreation. 
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- Select the required Device Type from the available dropdown for GMDs. 

- Provide the Username and Password for all SEM3 devices. 

- Import the JSON files to new powermanager to work with these devices. Refer steps from 

section 4.1 Prerequisites for Import > Create the third-party device types to import JSON files 

to new powermanager.  

- Click Create Devices. 

 

• Switch to operating mode and start all device communication. 

 

• Ensure only files and folders shown in below screenshot are present in migration file path.  

 
 

• Switch to Engineering mode and navigate to Migration tab to proceed with the import 

operation. 
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4.2 Configuration and Data import 

Perform the following steps to proceed with configuration import. 

• Select the folder with the migrated files under the Import expander. 

 
Select the folder exported from powermanager V3.6 HF1: Allows you to select the folder with the 

configuration or the data export. 

 

Step 1 – Configuration Import: Allows you to import the file containing the configurations.  

Username: Enter software account username for new powermanager. 

Select path: Select the folder to export the schedule reports. 

 
 

Step 2 – Data Import: Allows you to import the file containing the data. 

 

The configuration and the data import are successful.
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NOTE: You are recommended to verify all the configurations in new powermanager 

system after migration. 
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5 Migration Summary 
Configuration Export, Data Export, Configuration Import and Data Import are the activities 

performed during migration. After every export and import activity, migration summary report will 

be created for each activity.  

Export summary will be available as <Exported Folder>/Migration_Export_Summary.txt 

Import summary will be available as  

<Project Path>/Data/Migration/Migration_Import_Summary.txt 

NOTE: You can compare between export and import summary reports to get the migration status. 
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6 Troubleshooting 
Troubleshooting 

Error Situation What to do 

Data import could not start User clicks on data 
import with incorrect 
HDB configuration 

1.Verify if HDB is linked to the 
project. 

2.Verify if Siemens GMS HDB service 
is running in SMC (system node 
>management tab >services 
section). 

3.Verify if short term and long term 
archives/storages are created in 
HDB and in ON state. 

After performing above 
troubleshooting, proceed with data 
import. 

Migration tab is not available after login 
to new powermanager 

Migration EM is not 
installed or not added in 
the project 

If Migration EM is not installed, 
refer section Import to new 
powermanager. 
If migration EM is not added in the 
project, click Add to project and add 
powermanager migration EM. 

Server is not properly running during 
import in new powermanager 

 

Migration(import) 
running on HDB writer 
manager goes to blocked 
state in SMC 

User should wait till completion of 
complete migration activity. 

The scheduled report file is corrupted User trying to open the 
generated scheduled 
report file 

In powermanager application re-
save the report definition. 

 

1. Read the notes in the Readme.pdf file carefully.  

2. For up-to-date hot fixes / service packs for powermanager see: 

www.siemens.com/Powermanager/support 

For further support, see the Technical Support information below. 

Technical Support: Internet: http://www.siemens.com/lowvoltage/technical-support 

 

https://support.industry.siemens.com/cs/products?mfn=ps&pnid=19789&lc=en-WW
http://www.siemens.com/lowvoltage/technical-support

